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Lesson 1

Working Drawings (1)

During the design process, an engineer records ideas by means of sketches and design drawings
of prototypes and their development. Once satisfied with the degree of perfection, the sketches are
handed over to the draftsman who “takes off” the detail and makes working drawings of the whole
unit. O

A set of working drawings for a machine would include detail drawings of the various parts and
an assembly drawing showing how these parts are assembled to make up the complete machine. @

Detail drawings The detail drawing is used as the main reference in the manufacture of indi-
vidual components. It should contain sufficient information to manufacture the part as well as suit-
able, fully dimensioned orthographic view of each part, together with other information that may be
required in the manufacturing process. @ A complete detail drawing should contain at least the fol-

lowing information (not necessarily in order of importance) (Fig.1.1):

Sym Revision Dato | Appd

A MlGxZwu-é—wm 1:5:76 | FN.

0°* chamfer
Center drill Hex. 24 A/F

®
wt top ¢ 413 M16x2-6H

L iF-—-

R1 2x43°

1 39

e

Dims. in mm @ E_ % Dm. AB.5:4:76 | ASHAMBLESPTY.LTD
Ckd. J.M. 6:4:76

Tolerances: Appd. FN.8:4:76

Material . 8:4: SPINDLE CAP
$0.1 all over MS Issued K.S. 9:4:76

Finiah Ref. Size: A4 | Dwg No:17644
AS 1100 v Assy No: 17645 [Scalo1:2| Sheet2 of4

Fig. 1.1 A detail drawing

Sufficient orthographic views of the part concerned.
Dimensions and instructional notes.

Scale used.

> PN -

Projection used, for example, first or third angle.




1
2
3
4
- 5.
6
7
8
9

4 Mk F R 3EE (52 8K)

Drafting standard reference, for example, as 1, 100.
Name or title of drawing.

Dimensional units which apply.

Tolerances where necessary.

Surface finish requirements.

Special treatments needed.

. Type of material used.
. Names of draftsman, checker, approver, ete.

. Relevant dates of action by those concerned.

Zone reference system when necessary.

. Drawing sheet size. *

Name of company or department as applicable.

. Drawing sheet reference, for example, sheet 1 to 2.

New Words and Expressions

(DOnce satisfied with the degree of perfection, the sketches are. handed over to the draftsman

. working drawings n. T/EH
. sketch [sketf] n. BHE, RE
. prototype [ 'proutotaip] n. JHEI, REHL
. development [ di'velopmont] n. & &, B4
perfection [pa'fekf(a)n] n. 525, BE
. draftsman [ 'dra:ftsmon] n. 2E R
. detail ['disteil] n. B g, EA; EE
. assembly [a'sembli] n. ZEE
. individual [ indi'vidjusl] a. 4N3IEY
10. component [kom'pounont] n. B, I
11. dimension [di'menf(3)n] n. R~}
12. orthographic [ o:0ou'grefik] a. IEAH, IEHRETH
13, view [vjur] n. FHE
14. in order of -+ - WwF
15. instructional [in'strakf(o)nol] a. 5 f, VEIBHK
16. projection [ pro'dzekf(a)n] n. #E
17. tolerance [ 'tolorons] n. /A3
18. finish [finif] n. &35
19. approver [o'pruivo] n. #t¥EH
20. relevant ['relivont] a. X, HEH
21. zone [zoun] n. #, JEE, XiR
22. applicable ['eplikobl] a. &3EH, BEN M
Note
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who “takes off” the detail and makes working drawings of the whole unit.
‘] who 3| B R B M2 1E M F], &M the draftsman, takf;s off Bh: Hflo
FI: M REMEN, FERXSALEBRAHMRENBRETEE.
@A set of working drawings for a machine would include detail drawings of the various parts
and an assembly drawing showing how these parts are assembled to make up the complete machine.
] - showing- - B BLFE 43 1R 1B VR 18 , 1Bffi an assembly drawing, how 5] RIEIEMA],
B —ENBNIARAES T RHENTHEN—KERE, RERBRXEFHFM
AT e AR SE B B PR o

@1t should contain sufficient information to manufacture the part as well as suitable, fully
dimensioned orthographic view of each part, together with other information that may be required in
the manufacturing process.

47 to manufacture the part AR EREIEME B HRIE. that SIFRHEEBEND, B
other information, . ‘

B ENATHESHEENES, URESNFHNARASERTHIERE, UR
HEREFRFHEMER. -

Exercises

1. Translate the following terms into English.

(1) THEE 2) 2HE ) EZEE 4) #E () BfK

2. Translate the following sentences into Chinese. )

(1) The three principal views of an object. are the front view, the top view and the left side
view. ‘

(2) Sometimes in representing a complex object, it is not enough to draw its three views only,
so the six principal views of an object in the same plane are adopted.

(3) The partial view is only a part of an object which is projected to the principal projection
plane, the partial views are also bordered with a break line.

(4) 1f two cylinders are with no difference in diameter, then the projection of intersection will
appear as two straight lines.

(5) Any solids of geometric combination, no matter how complex, can always are decom-

posed into several simple shapes.and parts.

Reading Material

Working Drawings ( II )

Assembly drawings Assembly drawings are primarily used to show how a number of compo-
nents are fitted together to make a complete product unit. The term subassembly is commonly applied
to a product unit which combines with other subassemblies to make an assembly. For example, an
assembly drawing of a motor car engine would show a number of complete units included on the
drawing. Each of these units is referred to as a subassembly of the engine assembly..

Assembly drawings may be divided into two types depending on the proposed use:



 A— —

C.% 6 nbEREE (B2 )

1. General assembly where the main purpose is to identify the individual components and show
their working relationship;

2. Working or detailed assembly combined detail and general assembly drawing which provides
the function of both types.

Features of a general assembly drawing are:

1. Views are selected which show how the parts fit together and indicate how the unit may function.

2. Sectional views are used to eliminate the use of hidden detail lines where possible.

3. Dimensions which relate to the function of the unit as a whole are indicated, for example,
the maximum and minimum operating heights of the jack.

4. Individual components are identified by the use of numbers contained in circles, which are
connected by leaders to the related parts.

5. A parts list relates to the numbers on the drawing and identifies the component.

6. A revision table is provided to record modifications to individual components which may
occur from time to time. '

7. Some assemblies may be so large that it is necessary to draw different views of the assembly
on separate sheets.

Features of a working assembly drawing are:

1. Only simple assemblies are drawn in this manner as views have to be chosen which show the
assembly relationship as well as sufficient dimensional details of individual components to enable
their manufacture.

2. It is ideally suited to furniture construction drawings where the assembly views are not com-
plex and details of joints may be enlarged and shown as partial views.

The information provided on a general assembly drawing is somewhat different from that
required on a detail drawing. Information on the manufacture of individual parts is not required, for
example, surface finish, tolerances or treatments. However, assembly instructions are required as
are dimensions which may be used for installation purposes or which are relevant to the operation of

the assembly as a working unit.

Words and Expressions

1. subassembly [saba'sembli] n. ¥4

2. identify [ai'dentifai] oe. jHF|, #4----- #ARiT
3. modification [ ;modifi'keif (o)n] n. {&k; ik
4. furniture ['fomitfo] n. & &

5. enlarge [in'la:d3] »i. Kk

6. joint [d3oint] n. Fe, L

7. partial ['paifol] a. TWAH, FTWH
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Lesson 2

Creating Drawings with AutoCAD

This text introduces AutoCAD for Windows, a software widely used in industrial design and

production.

When you first start AutoCAD, an empty, unnamed drawing is open. You can begin working
with this drawing immediately.

To create a new drawing using Start from Scratch

1. From the File menu, choose New.

2. In the Create New Drawing dialog box, choose Start from Scratch (Fig.2.1).

3. Under Select Default Setting, select English or Metric, and then choose OK. The drawing
opens with the default AutoCAD settings.

4. From the File menu, choose Save As.

5. In the Save Drawing As dialog box under File Name, enter a name for the drawing and
choose OK.

The drawing extension (. dwg) is automatically appended to the file name.

Fig.2.1 Create New Drawing dialog box

Working with layers
An AutoCAD drawing can have layers, similar to the transparent overlays drafters use to create
pencil drawings. For example, in a drawing of a house you can have the wall lines on one layer, the

electrical wiring on a second layer, and plumbing on a third. It’s helpful to use different colors for

different layers so you can tell them apart.
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To create a new layer

1. From the Format menu, choose Layer.

2. In the Layer and Linetype Properties dialog box, choose New (Fig. 2. 2). A layer called
Layerl is displayed.

3. Click Layerl and enter a new layer name.

The layer name can include up to 31 characters. Layer names can contain letters, digits, and
the special characters dollar sign ($), hyphen ( -), and underscore ( _). Layer names cannot
include blank spaces. .

4. To change a layer’s color, select the layer and click its Color icon. In the Select Color dialog
box, select a color and choose OK.

" 5. To change a layer’s lixietype, select the layer and click its Linetype icon. In the Select Line-
type dialog box, select a linetype.

6. Choose OK to exit each dialog box.

' Continuous '
Center
Hidden

L B
o
[} Continuous
il o

Continuous

Fig.2.2 Layer and Linetype Properties dialog box

New Words and Expressions

1. unnamed [ An'neimd] a. FA4 K - R
2. from scratch M B

3. menu ['menjur] n. EH
4. dialogue box X}iEAHE

5. default [di'fo:lt] n. ERIA
6. extension [ik'stenf(o)n] n. I B4

7. layer ['leia] n. () B

8. transparent [ treens'peront] a. 3% BH )

9. overlay [ouvo'lei] n. B (&)

10. drafter ['dra:iftor] n. BEA; HIEGR, HERE
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11. wiring [ 'waiorig] n. ££§%, B2

12. plumbing ['plamin] n. &if

13. format ['format] n. R

14. property [ 'propati] n. MR

15. character [ 'karikto] n. &

16. digit ['didzit] n. FTHi{EEFE

17. hyphen [ 'haifon] n. HEFE

18. underscore [ ando'sko:] n. FRIZ, K&
19. icon ['aikon] n. E*R

20, linetype [ 'laintaip] n. 2R %Y

Notes

AutoCAD for Windows J& H B {# FI1R /" ¥Z B — Fh i3 L4 B 8t 31 5 4 B B o A BRIR
5 B HIE SO B SCfF (Help) o #5 BY SO R % A 2% 39 3 S5 AL 3k 4 ief 2 3l 3 A4 28 38 3
o BAGRHL YR SUR M H B S 2+ EE

Exercises

1. Translate the following terms into English.

(1) g (2) XMEE 3) BARE ) BHFH ) EE (6) B

2. Translate the following paragraph into Chinese.

To create a text style

(1) From the Format menu, choose Text Style.

(2) In the New Text Style dialog box, choose New.

(3) In the New Style dialog box, enter a name for the text style.

The new style you’ve created has all the characteristics shown in the Text Style dialog box. You
can continue to change characteristics, such as the font, or you can do it later.

(4) Choose OK to close the New Style dialog box.

(5) If you have made any changes to the style characteristics, choose Apply to save them.

(6) After you have made and applied all changes to the text style, choose Close. ( Cancel be-
comes Close after you choose Apply. )

Reading Materiall

Establishing Basic Settings in AutoCAD

When you start AutoCAD, it creates a new unnamed drawing for you. You can either start
drawing objects in this blank drawing or open an existing drawing.

If you open an existing drawing, all of the command and system variables settings last used on
that drawing are restored because this information is saved in the drawing file.

When you start a new drawing, there are a few settings you will want to establish to assist you

during the drawing process. The Setup Wizard will assist you automatically; however, you can




